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Movavi Photo Editor
Quick Start Guide

Movavi Photo Editor is a versatile photo editing tool that can help you easily fix and enhance your photos.
 
Step 1: Open a photo
Drag and drop a photo from Windows Explorer onto the Photo Editor window, or click Browse for Images to open a photo.

Step 2: Edit the image
Next, use the tools to edit and improve the image. Click a button on the right sidebar to open the tab with the corresponding
tool, and then modify the image as you see fit.
 
Editing the photo dimensions
Use the Rotate tool if you need to rotate or flip a photo, or fix the photo's horizon level.
Detailed instructions

Use the Crop tool if you need to cut off the edges of the photo or change its proportions.
Detailed instructions



 

 

Use the Resize tool if you need to export a smaller copy of the image.
Detailed instructions

Erasing objects and retouching
Use the Object Removal tool if you need to remove unwanted objects from the picture or fix some defects.
Detailed instructions

Replacing the background
Use the Background Removal tool if you need to cut out a picture's background. You can leave the background transparent
or replace it with a color or a different image.
Detailed instructions



 

 

Adjusting colors
Use the Adjust tool to fix a photo's colors or add a creative touch. Click the Magic Enhance button for a quick automatic
enhancement, or use the sliders to manually improve the brightness, contrast, saturation, and other properties.
Detailed instructions

Applying effects
Use the Effects tab to apply a creative effect to a photo. Simply click on an effect you like to apply it to the image.
Detailed instructions

Adding text
Use the Text tab to add text boxes to the image. You can add as many lines as you like and fully customize the font and
position. With a combination of effects and text you can make creative greeting cards and motivational posters.
Detailed instructions



 

 

Step 3: Save the image
1. Click the Export button at the bottom of the window.
2. Choose a folder and name the new image.
3. Click Save.
More on saving images
Changing image format



 

 

Removing trial restrictions
When you first install a copy of Movavi Photo Editor, it will be running in trial mode, where you cannot save the edited
images. To be able to use the program to its fullest, you will need to activate it using an activation key that you can purchase
from our official website or any of our partners.
 
Follow the instructions below to activate your copy of Movavi Photo Editor:
 
Step 1: Buy activation key
1. Click the button below to go to the purchase page and click the Buy Now button there.

 
2. You will be taken to our web store. Fill in your billing information and payment options and proceed with the purchase
form. IMPORTANT! Be sure to enter a valid e-mail address: it will be used to deliver your activation key.
3. Once you have placed your order, you will shortly receive a confirmation for your order and an e-mail from
support@movavi.com containing your activation key.
 
Step 2: Open the activation window
1. Open Movavi Photo Editor.
2. Open the Help menu and choose Activate Software. The activation window will appear.

Step 3: Enter your activation key
1. Enter the activation key into the corresponding box.
2. Click Activate to complete the activation.
This step requires a working Internet connection to verify your key. If you aren't connected to the Internet, try offline
activation.

Having problems with activation?
If activation is not working as expected, try the following:

• Make sure that the activation key is entered correctly and is intended for the program you are activating.
• Try activating offline via e-mail.

http://www.movavi.com/picture-editor/buynow.html?asrc=pe_help
http://www.movavi.com/picture-editor/buynow.html?asrc=pe_help


 

 

• Contact us at support@movavi.com and we'll help you solve the problem!

 
Activating without Internet access
If the computer you have installed Movavi Photo Editor on is not connected to the Internet, you can activate the program
via e-mail.

mailto:support@movavi.com


 

 

Getting an activation key
You can purchase an activation key from the official Movavi website or from any of our partners. To purchase a digital copy
from the official website, follow the steps below:
 
Step 1: Go to the purchase page
To open the purchase page for Movavi Photo Editor:

• In the Help menu, choose Buy Activation Key, or
• Follow the link below...

Step 2: Choose a license type

• If you plan to use Movavi Photo Editor at home, click Buy Now on the purchase page to proceed with buying the personal
license.

• If you plan to use Movavi Photo Editor at work, in a government institution, or gain profit in any way, go to the Business
license tab on the purchase page.

 
After that, you will be redirected to an online store depending on your region and the available payment methods. All of our
vendor partners are secure and completely safe.
 
Step 3: Fill in your billing details
1. Choose any of the available payment methods.
2. Fill in the information required on the page.
3. Enter a valid e-mail address. This e-mail will be used to deliver your activation key.
 
Step 4: Get your activation key
After the purchase has been verified, you will receive a letter containing your activation key. Now you can use it to activate
the program.
Activation instructions
Activating without Internet access

If you haven't received your activation key within the hour:

• Check the Spam folder of your mailbox,
• Contact support.

http://www.movavi.com/picture-editor/buynow.html?asrc=pe_help
http://www.movavi.com/picture-editor/buynow.html?asrc=pe_help
http://www.movavi.com/support/contact.html


 

 

Activating Photo Editor
Activating Movavi Photo Editor will let you use the program forever and save your photos. Activation requires an Internet
connection to verify your key.
 
You will need:

• Movavi Photo Editor activation key. You should receive your key via e-mail right after your purchase is completed. Don't
have a key? Buy now

• Internet access to verify your key. Don't have Internet access? See this guide on offline activation

 
Step 1: Open the activation window
1. Launch Movavi Photo Editor.
2. Open the Help menu and select Activate Software. The activation window will open.

Step 2: Enter your activation key
1. Enter or paste your activation key into the corresponding box of the Activation window.
2. Click Activate to verify your activation key.
This step requires a working Internet connection to verify your key. If you aren't connected to the Internet, try offline
activation.

If you have entered the key correctly, you should see a message confirming successful activation.  Click OK to complete the
activation process and restart the program.

Having problems with activation?

• Check that the activation key is entered correctly and is intended for the program you are activating.
• Try offline activation,
• Contact our support team.

 

http://www.movavi.com/picture-editor/buynow.html?asrc=pe_help
http://www.movavi.com/support/contact.html


 

 

Activating without Internet
Activation requires Internet access to verify your activation key. If you don't have a working Internet connection on the
computer that Movavi Photo Editor is installed on, you can activate the program via e-mail using any other computer or
device. You will be asked to send us an automatically generated e-mail and then enter the reply into the program's Activation
window.
 
You will need:

• Movavi Photo Editor activation key. You should receive your key via e-mail right after your purchase is completed. Don't
have a key? Buy now

• A device or another computer that can be used to send and receive e-mail.

 
Step 1: Open the activation window
1. Launch Movavi Photo Editor.
2. Open the Help menu and select Activate Software. The activation window will open.

Step 2: Enter the activation key
1. Enter or paste your activation key into the corresponding box of the Activation window.
2. Select the Activate offline option.
3. Click Activate to proceed to the next step.

Step 3: Send an e-mail with the provided information
The next window contains important activation information that you will need to send us via e-mail in order to activate your
program.

http://www.movavi.com/picture-editor/buynow.html?asrc=pe_help


 

 

1. Click the Copy button to copy the information in the window. If necessary, save or transfer this information to the computer
or device that you will be sending the e-mail from.
 
2. On the computer with an Internet connection, open your mail client and compose a new e-mail. Paste the information
you've copied earlier into the message body and send this e-mail to reg@movavi.com. The activation server will then verify
your activation key and send you an automatic response containing a registration key, which you will need to enter into the
Activation window. You should receive the server's reply within an hour.

Step 4: Enter your registration key
1. When you have received your registration key, save it and go back to the Activation window.
2. Enter the registration key into the corresponding box.
3. Click Activate to submit the information.

mailto:reg@movavi.com


 

 

Once activation is complete, you may be asked to restart the application.

If you're having problems with offline activation:

• Make sure that the keys are entered correctly and are intended for your version of Movavi Photo Editor.
• Make sure you have administrator rights on your computer.
• Contact our support team.

http://www.movavi.com/support/contact.html


 

 

Open images
To begin editing an image, you will need to open it in Movavi Photo Editor.
 
Drag-and-drop
Find the necessary image in Windows Explorer and then drag it from Windows Explorer right onto the Photo Editor window.

Browse
On the start screen, click the Browse for Images button. A Windows Explorer dialog box will appear. There, choose the file
you want to edit and click Open.
 
Recent file
On the start screen, click Open last edited file. The thumbnail next to it shows which image was opened last.

File menu
Open the File menu and choose Open. A Windows Explorer dialog box will appear. There, choose the file you want to edit
and click Open.



 

 

See also:
Saving images



 

 

Zoom and navigation

Zoom
When you open an image, it will be fitted to the window size. Use the zoom and navigation tools at the bottom of the window
to set a comfortable view.

 

Fit to screen – adjusts the zoom level so that the entire image can fit in the window.

Actual size – sets the zoom level to 100%, displaying the image as it is.

Hand tool – to move an image around while zoomed in, click the hand icon and hold the left mouse button to move
the image. Then, click the hand icon again to go back into editing mode. You can also move the image at any time by
holding the right mouse button.

 
To magnify an image, use the zoom slider at the bottom of the window. You can also zoom in and out using the mouse
wheel. When you zoom in or out, the current zoom level will be displayed to the right of the navigation controls.

Navigation
Now you can sort through entire photo folders and edit their contents on the fly. Use the file navigation buttons at the bottom
of the window:
 

Go to the previous image in the folder.

Go to the next image in the folder.

Delete the current image.



 

 

Click and hold to view the original of this image before editing.

 
If you have made changes to the file before switching to the previous or next file, you will be asked to save or discard the
changes.

 



 

 

Image adjustments
The Adjust tab allows you to improve the photo's brightness, contrast, color, and other properties. Click the Adjust button
on the right to open the image adjustments.

Automatic adjustments
For an instant fix, click the Magic Enhance button. Movavi Photo Editor will automatically adjust the brightness and contrast
of your image.

Manual adjustments
If you need more specific adjustments, use the sliders on the Adjust tab to achieve the necessary result.



 

 

Brightness
Allows you to change the overall amount of light in the whole image, without changing any other parameters. When you
increase or decrease brightness, note how the histogram moves left or right, but maintains its original shape.
 
Contrast
Allows you to change the difference between the lightest and darkest parts of the image. This can help you make the image
more vivid, but too much contrast can cause unwanted posterization.
 
Saturation
Allows you to make the colors richer (positive values) or more subdued (negative values). Settings Saturation to -100 will
make the image grayscale. 
 
Hue
Allows you to change an image's overall color. Unlike tinting or color temperature (see below), changing an image's hue will
not color the picture in shades of one color, rather, it will shift all the image's colors in a given direction.
 
Temperature
Allows you to make the image feel warmer or colder, by adding orange or blue color respectively.
 
Tint
Allows you to add a red or green tone to the image, either for color correction, or for an artistic feeling.
Exposure
In photography, exposure is the amount of light that is allowed to reach the camera's sensor, which is usually achieved using
a combination of shutter speed, aperture, and lighting. If there is too much light on average, you may lose some details in
the dark parts, while the light areas may become 'washed-out', and vice versa. This allows you to imitate a higher or lower
exposure, as if you set it on your camera when taking the shot.
 
Gamma
Allows you to change how the middle tones appear on your image, without affecting the whites or blacks. 
 
Highlights and Shadows
These two sliders allow you to make each component more prominent in the image, and thus make the image darker or
brighter.
 
Blur
Allows you to slightly blur the image to reduce noise or smoothen out defects.
 



 

 

Sharpness
Allows you to sharpen the image to bring out more details. Please be aware that oversharpening an image can add noise.
 
If you've changed a few values but want to cancel all the adjustments, click the Reset button underneath the sliders.
 
Histogram
The histogram, located at the bottom, represents the distribution of colors and their shades in an image. When you view  a
histogram, it can give you information about how prominent a certain color is in the image, as well as about its brightness
and contrast. The left edge of the histogram contains the dark areas, while the light areas are on the right. For example, if
most of the colors are concentrated in the left-hand side, then the image is probably too dark, and vice versa. The height of
a color's graph represents its amount in the image. This way, you can use the histogram to aid you in adjusting the image's
colors.

Histograms of normal, underexposed, and overexposed images.



 

 

Applying effects
Adding an effect allows you to add a creative touch to your photos and easily convey your emotions.

 
Step 1: Click the Effects button on the right to open the effects tab.

Step 2: You will see a list of effect groups. Click on a group to open it and show the relevant effects.



 

 

Step 3: Choose an effect you like and it will appear on the photo!

Step 4: For some effects, you can use the Intensity slider under the effect's thumbnail to modify the effect's strength or
detail level.



 

 

Removing effects
To remove an applied effect, simply click on it once more.



 

 

Rotating images
The Rotate and Flip tab allows you to flip, rotate, and straighten out images with slanted horizon levels. Click the Rotate
button on the right-hand side of the window to open orientation options.

Rotate and flip images
Use the buttons on the Rotate and Flip tab to rotate the image by 90 degrees or to mirror the image.
    

     Rotates your photo 90° counterclockwise      Flips your photo horizontally (left to right)

     Rotates your photo 90° clockwise      Flips your photo vertically (upside-down)
 
Straighten images
A tilted horizon is a frequent problem for both beginner and experienced photographers when shooting from a handheld
camera. This tool allows you to easily correct tilting in your photos, and you won't have to worry about horizon levels when
taking your pictures.
 
The Angle slider allows you to manually rotate the image up to 45° either way.
 
Using the Level Tool:
The Level Tool can help you automatically straighten out the image.
 
1. In your photo, find a straight horizontal or vertical line. This can be the horizon, the side of a building, or any other lines
that are parallel or perpendicular to the horizon.
 
2. Now, click the Level Tool and trace that line on your image. Once you've traced the line, the image will be automatically
rotated to make that line exactly horizontal or vertical.



 

 

 
 



 

 

Cropping images
Cropping an image allows you to save it with a different aspect ratio, remove unwanted parts from the edges, and zoom in
on objects inside the image. We recommend that you save a backup copy of the image before cropping, in case you need
the original image later. Click the Crop button on the right-hand side of the window to open the Crop tab.
 
Step 1: Open the Crop tab
Click the Crop button on the right to open cropping options.

Step 2: Define size
Next, specify the size and proportions that you want. There are several ways to set the size:
 
Crop frame
A crop frame will be visible over the image. Drag inside the image to draw the cropping rectangle, or move the edges of the
crop frame with your mouse.
 
Pre-defined sizes
Open the drop-down box and select a suitable size from the list. Here, you can find some commonly used sizes and presets
for quickly changing the proportions of the image.
 
Manual input
If you need a specific size in pixels, you can manually enter the width and height into the corresponding boxes. To switch

the width and height, click the Invert Proportions icon .
 
Lock aspect ratio
Selecting this option will maintain the selected width to height proportions. This way, when you change one dimension of the
cropping rectangle (whether by drawing the cropping area or by entering a number for width or height), the other dimension
will change accordingly to keep the selected aspect ratio.



 

 

Step 3: Apply changes
Click the Apply button to accept the cropping changes. To discard the changes, click Reset.

Don't forget to save your image!



 

 

Adding text
The Text tab allows you to add text to your images. Use text to create image postcards, but remember – a picture is worth a
thousand words!

 
Step 1: Click the Text button on the right to switch to the Text tab.

Step 2:  In the Text tab, click the Add Text button. A new text area will appear in the photo.

Step 3: Click inside the text area and enter the new text.



 

 

Step 4: Choose a font, size, color for your text.

Step 5: Drag the text area with your mouse to place it inside the image. To rotate the text area or resize the text, drag at the

 resizing button in the bottom right-hand corner of the text area.



 

 

Removing text:

•
Select a text area and click the  button in its upper left-hand corner to remove just that one caption.

• To remove all captions, click the Remove All Text button in the Text tab.



 

 

Resizing images
Resizing images allows you reduce an image's file size, prepare pictures for uploading to web albums, which often have a
size limit, or prepare web-sized images for blogs and websites.
 
Tips:
If you intend to make other edits to the photo, it is best that you do them prior to resizing it, since the image quality will then
be preserved better. Also, we recommend that you save a copy of the image before resizing in case you may need it later,
especially if you plan on printing out the image.
 
Step 1: Go to the Resize tab
On the right-hand panel of the window, click the Resize button to switch to the Resize tab.

Step 2: Enter new dimensions
Select or enter the necessary image size:

• The Fit into box allows you to select from the most common image sizes, as well as presets for printing and exporting
images. 

• To enter a custom image size, enter the dimensions into the width and height boxes. You can change the measurement
unit in the box on the right. The default unit is pixels.

• To avoid visual distortions of the image after resizing, keep the Constrain proportions option enabled.



 

 

Step 3: Apply changes
Finally, click Apply to resize the image to the specified size. Don't forget to save the image when you're done!



 

 

Erasing objects
The Object Removal tab can help you erase unwanted objects or people from your images. With a special algorythm, the
background is reconstructed as if the deleted objects were never there. All you need to to is mark the objects you want to
remove.

Step 1: Switch to the Object Removal tab.

Step 2: Choose a selection tool
At the top of the Object Removal tab, choose a tool you're comfortable using.



 

 

  Use the Brush to freely paint the red selection
area. The Size slider below will set the brush size.

  Use the Magic Wand tool to select adjacent areas of
uniform color in a single click.

  Use the Lasso tool to outline an object. Click the arrow on the lasso icon to change the type of lasso:

 The standard Freehand Lasso allows you
to freely draw the object's outline.

 The Polygonal Lasso allows you to outline the
object with straight lines.

  Use the Eraser to deselect parts of the image. Just like with the brush, you can change eraser size with the slider
below. (The eraser only affects your selection, it does not erase objects in the photo)

    Use the Clone Stamp Tool to select a part of the image to transfer onto another part of the image. You can use
the Clone Stamp Tool to mask small blemishes or duplicate objects.
 
 
Step 3: Mark unwanted objects
Using the selected tool, mark the objects you want to delete in the image. As you paint, these objects will be marked with
red.



 

 

The people marked with red will be removed from the image.
Tips and hints:

• If you've made a mistake, use the Eraser  to deselect parts of the image. Just like with the brush, you can change eraser
size with the slider under the tools.

• When selecting people and objects, don't forget about their shadows and reflections.
• If you need to erase several objects, you can select them all at once or erase them one by one.
• To clear all selections from the image, click Reset Selection.
• If you need to make the selection larger or smaller on all sides, use the following keyboard shortcuts:

Ctrl+Shift+P to expand the selection
Ctrl+Shift+M to contract the selection
 

Step 4: Set Variation
When you remove an object, the program will replace that object with pixels from the rest of the image, so as to blend into
the background. The Variation slider affects how far away from the object the replacement pixels can be taken from. For
lower variation values, the replacement pixels will be taken from the area only directly adjacent to the object, while at 100
they can be taken from any part of the image.



 

 

Different variation values will provide different results depending on the size of the object, its background, and the overall
uniformity of the image. Try out a few values to see which works best for your pictures.
 

For example, in this image it would be best to select a lower variation so that the sea is not cloned onto the sand.
 
Step 5: Erase!
Click the Start Erasing button to begin processing. Please note that erasing objects with high variation values will take
slightly longer. If you aren't satisfied with the result, you can click the Undo button and adjust your selection or choose a
different variation value. Repeat steps 3-5 to remove any other objects you want.



 

 

Step 6: Clone retouching (optional)
If there are some more small defects left over after erasing, you can manually correct them with the Clone Stamp tool. You
can select a patch of the image and copy it over the defects.
 
1. Select the Clone Stamp tool
2. Hold down the Alt key and click onto the part of the image that you want to clone. Usually, it should be close enough to
the blemish so that the copied spot is similar to the original in color and texture.
3. Paint over the blemish with the copied sample. The source will also move as you paint with the stamp, in order to give a
more natural look to the edited parts.
Learn more about clone retouching



 

 

Clone stamp retouching
Located on the Object Removal tab, the Clone Stamp tool can help you manually correct small blemishes, remove wrinkles,
or clone (copy) objects on an image.
 
Step 1: Open the Object Removal tab
Click the Object Removal button to open the retouching options.
 

 
 
Step 2: Select the Clone Stamp tool
Click the stamp icon at the top to select the Clone Stamp tool.

Step 3: Set the stamp size and softness



 

 

Use the Size slider beneath the tool icons to set the stamp's size.
Increasing Softness will make the stamp's edges more transparent, which can help you blend the stamped parts with the
rest of the image.

Step 4: Pick a source
Move your mouse pointer over to the area that you want to clone (e.g. a similar area without blemishes). Hold down the Alt
key and click on the image to define a source point.

Step 5: Paint over the target
Release the Alt key. Then, move your mouse pointer to where you want the cloned fragment to appear and paint over the
area you want to replace. As you move your cursor while painting with the stamp, the sampled area will also move relative to
your cursor position.



 

 



 

 

Erasing backgrounds
Movavi Photo Editor can help you quickly and easily cut out people and objects from any background. You can use it to
create product photos, funny collages and more.

Step 1: Open the Background Removal tab
On the right-hand side of the window, click Background Removal.

Step 2: Mark the foreground and background

1.  Click the Brush + icon and roughly mark the foreground objects that you want to keep. There is no need to color
the entire object, but if the objects has a lot of small details, you may need to add a few extra strokes.

2.  Click the Brush - icon and roughly mark the background that you want to remove. Pay closer attention to parts of
the background that have similar color or pattern to that of the foreground.

3.  If you've made a mistake, click the Eraser button and remove the selection.
 
Once you've marked the foreground and background areas, Photo Editor will outline the foreground object with a yellow line.
Sometimes, you may need to correct this outline by adding a few strokes of the green or red brush. For higher precision, use
a smaller brush size or zoom in on the details.



 

 

4. Depending on the amount of detail around the edges of the foreground object, you may want to change how the edges
are detected. Try different Boundary Smoothness values to find which works best for your image.

Step 3: Cut out the background
1. Click 'Step 2: Set New Background' on the Background Removal tab. The background will be cut out and you can
proceed to choosing the new background.



 

 

2. Now, you can choose to leave the background transparent or choose a new background color or image.

Transparent:

If you want to keep a transparent background, click the 'transparency' icon to the left of the color palettes .
 
Grayscale colors:
To use a standard white, grey, or black background, choose one of the color icons.
 
Custom color:
To choose a different color, click the arrow on the rightmost color sample to open the palette. Click More in the palette to
open the standard color selection dialog box where you can mix a custom color.

 
Image:
To open an image to use as the background, click the Image File button and select the file you want to use. It will then be
added as the new background. After that, you can move and resize the foreground objects on the new background. If you

switch to a color or transparent background, you can later return to using the image by clicking the image icon  next to
the Image File button.



 

 

 
 
3. If the edges of the foreground object look too sharp, use the Blur Edges slider to blend them with the background.
 
4. Use the Shift edges slider if you need to shrink or expand the entire selection. This can be useful for objects with a lot of
details around the edges.
 
Step 4: Move and resize the object

Click and drag your object to move it anywhere you want in the image. Drag the blue circle icon  to change the object's
size.
 
If the object is much smaller than the original image size, you can later crop the image.
 
Step 5: Apply changes
Finally, click Apply to accept the changes. Please note that if you switch to another tab while removing a background, your
selection will be lost.
 
If you want to cancel cutting out the background and discard the selection, click Reset.

Don't forget to save your changes! If you've left the background transparent, make sure to save the image in a format that
supports transparency, such as PNG, BMP or TIFF.



 

 

Saving images
Step 1: Click the Export button in the bottom right-hand corner or open the File menu and click Save to rewrite the
previous image, or click Save As to save the image under a different name.

Step 2: In the Save File dialog box, choose where you want to save your image.
 
Step 3: If you want to save the image in a different format, open the Save as type list and select the format you want.
 
Step 4: Finally, click Save.



 

 

Changing image format
Changing an image's format allows you to use your images in a wider variety of situations or compress the images to a
smaller file size. Many websites only allow a limited number of formats for uploading, so having a tool to easily change
image format becomes a must.
 
Step 1: After you've opened and edited an image, click Export in the bottom right-hand corner of the window. The Save
File dialog box will open.

Step 2: To choose an image format, open the Save as type box and select the format you need.
If the format lists multiple file extensions, such as *.jpg, *.jpeg and others for JPEG, you can type the necessary file
extension in the file name field.
 
Advanced:
Some formats also allow you to set image quality and compression method. For these formats, click the Options button in
the Save File dialog box to open these options.
 
JPEG Quality
Drag the slider to the necessary quality level and click OK. Lower quality allows you to compress the image to a smaller file
size, but will probably not look as good.
 
TIFF Compression
Select the preferred compression method and click OK:

• Uncompressed: no compression method will be used. The image will be much larger in size than its compressed copies,
but uncompressed images with large resolutions may be processed faster by some software.

• PackBits: offers less compression than LZW, but is the most widely supported compression method, especially on Apple
software.

• LZW: compresses the image to about half size.
• ZIP: best for working with 16-bit images and average for 8-bit images.



 

 

Step 3: Choose where to save the new file and give your file a name.
 
Step 4: Click Save.
If you make any edits after saving the file in a different format, you will be working with the new file.



 

 

Image size and quality
Even though image files rarely take up more disk space than videos or other media files, a large photo collection can quickly
fill up your hard drive if you save all photos at the maximum size and quality. In this section, you will learn how to manage
image file size.
 
Image file size is defined by the following properties:
 
Image size in pixels
The larger the image, the more pixels it will be made up of, and the more data will need to be stored. The number of pixels
also defines image resolution for printing, and affects the maximum level of detail you can achieve for a print of a certain
size.
 
To reduce file size, you can resize the image. However, this comes at a cost: the smaller copy will look just as good, but if
you want to print out the image or use it as wallpaper, the smaller file will look considerably worse than its original.
 
Let's see how much disk space you can save by resizing images. Below are the file sizes for one image (here, you see a
scaled-down preview), and the difference is amazing, resizing a large image to a viewable 800x600 size makes the file size
over a hundred times smaller.
 

Dimensions File Size

7899x5924 px 27,6 MB

800x600 px 168 KB

 
If you want to upload previews of your images to the web, or share photos in web albums, resizing the photos will most likely
be a good idea: the upload times will be faster, and if you have a storage limit, it won't be filled up as fast as if you uploaded
the images at their original size.
 

Hint:
Don't scale up small, low-quality images.

An image with small dimensions does not have enough data in the file to allow
any program to fully restructure the quality of a larger size image. If you size

them up, you will only be wasting disk space without any improvement in quality.
 

Read our resizing guide
 
Image complexity
Image complexity plays a large role in file size. Due to image compression specifics, images with different content but
identical size and format will differ in file size because of the details that will need to be preserved. For example, if you save
a large image of a purely blue background, some compression methods will only need to store which color fills the whole
image, while for a picture of a flower, all the small details will be stored to avoid quality loss.
 
Note the images below. They are of identical dimensions and are both saved in JPEG format. One image is a photo of a
complex and colorful flower, while the other is a plain blue background. The second image's file size, having to encode less
data, is 48 times smaller than the first! And while you can't simplify your photos to a single color, keep in mind that some
images will naturally have larger file size than others.
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144 KB 2,98 KB
 
Format and compression method
A compression method can be seen as a shorthand writing system for image editing software, where it can write all the data
of your image into less space, and then decipher the shorthand to recreate the image on your screen when you open the file.
Most image compression methods do not store all of the image's data pixel by pixel, since it would take significantly more
disk space. Instead, the image compression algorythm finds a way to pack this information by finding identical parts and only
recording those same parts once, or by throwing away some data that it finds less important. Different formats have different
compression methods, and choosing the best format largely depends on the type and purpose of the images.
 
Lossless formats: some formats can store the image without losing any data, meaning that the quality of the image will not
decrease when you save it. These formats can store the image either at its full size, or use a lossless compression method,
that will pack the image into a smaller file, yet retain the original quality. No matter the compression level, these files are
rather large, but offer the benefit of higher quality and sharper images, which is especially important for text images and
logos.
Common lossless formats: PNG, TIFF, BMP
 
'Lossy' formats: other formats allow you to save the images into smaller files, but they compress images at the expense of
some quality. For large photos, the trade-off is usually justified, as the human eye will probably not notice the difference at
low compression levels. However, when manually adjusting quality of 'lossy' formats, such as JPEG, it is important not to set
the quality too low to enjoy the image.
The most common 'lossy' format: JPEG
 
When you change an image's format, note that saving it to a lossless format will not improve its quality, but only preserve the
existing data. Likewise, if you change an image from a lossless format to a 'lossy' one, some data will inevitably be lost to
compression.
 
Saving files in a different format
 



 

 

Printing images
Printing the image
To print out an image from Movavi Photo Editor:

1. Open the File menu and choose Print.
2. Choose the printer you want to use for printing the photo.
3. Click Settings to open the settings for the selected printer. The settings will vary depending on your printer's
software, but generally you can choose paper size, orientation and color options.
4. Choose the number of copies that you want to print. If this is your first time printing a photo, you may want to first
print only one sample copy to make sure you have set up everything right.
5. Click Print to begin printing!

 
Image printing guidelines
Follow these guidelines to ensure the best possible print quality:
 
1. Make sure the image is large enough for printing on the selected paper size, and conversely, choose the right paper size
for your images. If you print out small images on large paper, you may find that you can see individual pixels or that the
image is not smooth enough on print. Before taking the photos you want to print, use a camera with a high megapixel count,
make sure that it is set to the highest available quality (some cameras allow you to shoot smaller images than the camera's
maximum size), and provide good lighting conditions to minimize noise.
 
The larger the original photo, the larger a print size you can afford without losing crispness and quality. The standard for
printing images is to have at least 300 pixels per inch of the photo paper. The following table shows the correlation between
image size and its printed size when printed at 300 pixels per inch (~118 pixels/cm). You can use it to match paper size to
your image size and vice versa.
 

Camera Megapixels Image Size in Pixels Printed Size in Inches Printed Size in Centimeters
2 1600 x 1200 px 5" x 4" 13 cm x 10 cm
3 2048 x 1536 px 7" x 5" 17 cm x 13 cm

4 2464 x 1632 px 8.2" x 5.4" 21 cm x 14 cm

5 2560 x 1920 px 8" x 6" 21 cm x 16 cm
6 2816 x 2112 px 9" x 7" 24 cm x 18 cm
8 3264 x 2468 px 11" x 8" 28 cm x 21 cm
10 3872 x 2592 px 12.1" x 9.1" 33 cm x 22 cm
12 4000 x 3000 px 13" x 10" 34 cm x 25 cm
 
If you didn't find the necessary size in the table, you can easily calculate the printed size in inches by dividing the width and
height in pixels by 300. Likewise, to find out the minimum number of pixels for a certain print size, multiply the width and
height in inches by 300 to get the image dimensions in pixels.
 
2. You do not need to downsize the image before printing: the software will automatically fit the image onto the selected
paper size. Downsizing the image will only reduce quality.
 
3. If you need to crop unwanted parts of the image, make sure that the end result is not too small. If you have a very large
image, you can use the crop function to zoom in on objects in the image, but keep in mind that the output image size must
be large enough for printing. You can check the image size in pixels by clicking the File Information button on the bottom

panel: .
 
4. Use a high quality printer for printing out your photos. These simple guidelines will help you choose a printer:

• Inkjet printers are much better at printing images than laser printers. Dye sublimation printers are considered the best for
printing photos, however they are quite rare and can only be used for photo printing.

• Check the printer's dots per inch (DPI) resolution: the higher the DPI, the higher quality prints it will be able to produce. For
photo printing, make sure that the printer has at least 300x300 DPI.

• Generally, a dedicated photo printer will produce better results than a general-purpose multifunction printer of the same
price range.

• Some printers may produce colors different from the original because of the way they convert RGB color (the color
scheme you see on your monitor) to CMYK color (used for printing).

•



 

 

Be aware of your printer's maximum print size; many consumer printers only print photos up to 8 by 10 inches (20.32 x
25.4 cm). You should find this information on the packaging or in the printer's user manual.

 
5. Use high quality photo paper. There are different kinds of photo paper that may work differently depending on the content
of your image. For example, glossy paper is better at reproducing bright colors, while matte paper is more suitable for
portraits. Also, make sure that the paper matches your printer type (i.e. laser or inkjet).
 
Calibrating your Display
The colors you see in print may be slightly different than those you see on your display due to LCD monitor specifics. You
can try to calibrate your display for better previewing:
1. Open the Control Panel.
2. Type "Calibrate display" into the search box.
3. Click Calibrate display color. This requires administrator permissions.
4. Follow the onscreen instructions to calibrate your display.
 



 

 

Help and Support
If you have any questions or concerns regarding Movavi software, you are welcome to contact our support team. 
 
Write to us at suppport@movavi.com
or click the button on the right to ask a support specialist via live chat.
 
Please describe your problem in as much detail as possible; any screenshots or log files will allow us to help you faster. Our
support team specialists may ask you for additional information that is required to solve your problem: these may include
your license key, log files, and files you were working with, but never personal information. We value your privacy!
 

Have you checked the FAQ section?
Your question may have already been answered!

 
More questions:
How to activate Movavi Photo Editor
How to buy the software
How to update the graphics card drivers

mailto:support@movavi.com
http://www.movavi.com/support/


 

 

Supported Formats
 

Format
 

Input
 

Output
BMP

DPX

EXR  

GIF (non-animated only)  

JPEG

JPEG 2000  

JPEG-LS  

PAM  

PBM

PCX

PGM

PIC  

PIX  

PNG

PPM

PTX  

Sun Rasterfile  

TARGA

TIFF

WebP  

XBM

XFace  

XWD  
 



 

 

System Requirements
The minimum system requirements represent the lowest hardware specifications that are guaranteed to run Movavi Photo
Editor. If your computer meets the recommended configuration, then Movavi Photo Editor is sure to run smoothly on your
computer.
 

Minimum system requirements Recommended configuration

Movavi Photo Editor

Operating system Windows® XP/Vista/7/8/10 with latest service packs and patches

Processor Intel®, AMD® or compatible
processor, 1 GHz

2.2 GHz

Display resolution 1024x768, 32-bit color 1280x1024 or higher
RAM Windows XP, Vista – 512 MB

Windows 7, 8, 10 – 1 GB
Windows XP, Vista – 2 GB
Windows 7, 8, 10 – 4 GB

Available disk space 150 MB 1 GB or more

Additional requirements Internet connection

 



 

 

Updating Graphics Card Drivers
If you encounter an error message asking you to update your graphics drivers, you will need to download a new driver from
your graphics card manufacturer's website and install it on your system. Some graphics card drivers also have a useful utility
that notifies you when a driver update is available and updates the driver automatically. Keeping your graphics card drivers
up-to-date will ensure stable performance of applications and games on your computer.
 
Step 1: Find your graphics card manufacturer
1. Right-click your desktop and choose Screen Resolution.
2. In the Screen Resolution settings window, click Advanced settings.
3. This will open your graphics card properties. At the top of the window, your graphics card model will be listed under the
Adapter Type section. Note the full name of the graphics card somewhere for later.
 
Step 2: Download the new version
Now that you've learned your graphics card manufacturer and model, go to the manufacturer's website and find driver
downloads. There, look for the model or series that you've found earlier and download the driver installation file. Some
manufacturers may also offer a utility that will automatically find the necessary driver.
NVIDIA download center
AMD download center
 

Warning:
Only download drivers from the official manufacturer's website. Third-

party websites offering driver downloads may contain malware.
 
Step 3: Install driver
Once the file is completely downloaded, run the installation file and follow the onscreen instructions to install the driver on
your system. Your display may blink several times in the process. After the installation has finished, it is advised that you
restart the computer.
 

 
Updating NVIDIA® Driver
Modern NVIDIA graphics cards come with a special application called NVIDIA GeForce™ Experience that monitors driver
updates and allows you to optimize your computer's graphics performance.
 
1. Open the NVIDIA GeForce Experience application. It should already be installed on your system. If you cannot find the
application, please try the method above.
2. In the Drivers section, click the Check for updates button to find the latest drivers.
3. When the application has found a newer driver, click the Download driver button. From here, the software will
automatically download and install the necessary driver for your system.

http://www.nvidia.com/Download/index.aspx?lang=en
http://support.amd.com/en-us/download


 

 

Updating AMD® or ATI® Driver
 
1. If you have an AMD or ATI graphics card, go to the Driver Download Center on AMD's official website.
AMD Driver Download Center
 
2. Download the auto detect utility and run it when the download has finished. 
Auto Detect Utility
 
3. The utility will then automatically find your graphics card and help you download and install the right driver for your
system.
 
If the utility fails to find a driver for you, you can manually select your graphics card model and operating system on the
Driver Downloads page and download the driver.
 
4. After the driver has downloaded, run the installation file and follow the on-screen instructions to install it.
 
5. After the driver has been installed, it is recommended that you restart your computer.
 

If none of the above steps have helped, feel free to contact our support team via e-mail support@movavi.com or live chat.
 
If possible, please include the name of your graphics card model (see Step 1), as well as screenshots of any error messages
you have encountered. This will help our support team specialists solve your problem quicker.

http://support.amd.com/en-us/download
http://www2.ati.com/drivers/auto/autodetectutility.exe
mailto:support@movavi.com
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